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Chapter 1 Attention

Please read through this manual carefully before using the camera and follow the
instructions to avoid any damages that may be caused by improper operation.

1-1 Attention

The software CD-ROM packaged with the camera is designed for PC only. To play this
CD-ROM on a stereo or CD player may cause damage to it.

This camera is a precision electronic device. Do not attempt to service this camera yourself,
as opening or removing covers may expose you to dangerous voltage points or other risks.

Do not expose this camera under direct sunlight to avoid causing a fire.

1-2 Before Using Your Camera

Try to take some pictures before you perform the formal recording. Before taking pictures
with this camera of any important occasion (such as a wedding ceremony or on vacation),
do test the camera beforehand to ensure that it functions well. Any additional loss caused by
the malfunction of this product (such as costs of photography or any loss of benefit
generated by the photography) is not the responsibility of our company and no
compensation will be given for it.

Copyright information

Unless agreed by the right owner, all the pictures taken with this digital camera cannot be
used in violation of copyright law. Moreover, when "No Photography" restriction is placed on
site, you cannot record any live performance, improvisation or exhibits even for personal
purpose. Any transfer of pictures or memory card with data must be conducted under the
constraints of copyright law.

Notes on the LCD (Liquid Crystal Display) monitor

1. If the liquid contacts the skin:
Please wipe dry the skin with a cloth and wash with large amounts of water.

2. If the liquid gets in the eye:
Please immediately rinse with fresh water for at least 15 minutes and then consult with a
physician to receive treatment as soon as possible.

3. If anyone accidentally swallows the liquid:
Please rinse the mouth with water, drink large amounts of water and contact a physician
to receive treatment as soon as possible.
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1-3 Caution When Using the Camera
This product consists of intricate electrical parts. To ensure the camera photographs
normally, do not drop or hit the camera when taking pictures.
@ Avoid using or placing the camera in the following locations:

1. Damp and dusty places.

2. Sealed vehicles or places exposed to direct sunlight or places subject to
extremely high temperatures or heat.

3. Violent turbulent environment.

4. Locations full of steam, smoke, or oil fumes.

5. Locations subject to strong magnetic field.

6. In a rain or snow environment.

@ Do not open the battery cover when the power is on.

@ [f water has entered the camera, immediately turn the power OFF and remove the
batteries.

@ How to maintain your camera:

1. If the lens, LCD monitor or viewfinder surface is dirty, please use a lens brush or
soft cloth to wipe the surface clean instead of touching the lens with your
fingers.

2. Do not use any solid object to hit the camera to avoid scratching the lens, LCD
monitor or viewfinder surface.

3. Do not use any detergent or volatile solution, which will subject the camera case
and paint to dissolve or distort. Use a soft cloth only.

1-4 Package Contents

Please check if the following items are in the package when purchasing this product.
CD-ROM (incl. Camera Driver)

Pouch

Wrist Strap

2 x AA Alkaline Batteries

USB Cable

TV —-OUT Cable

User's Manual

Quick Guide
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Chapter 2 Getting to Know Your Camera

2-1 Names of Parts
Front & Side View

o 2]

Genigsy

00

o
(1)  Shutter Button (6) Lens
(2) Flash (7) Macro mode
(38) Lens Cover/ Power Button (8) Portrait and Landscape mode
(4) Viewfinder window (9) Terminal Cover
(5) Self-timer LED
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Rear View

0 00O

(1)
()
(©)
4)
(®)
6)

Power LED

Flash LED

LCD Monitor

Flash Button

Mode Display /Power Button
Strap Holder

600 00

(7) Mode Dial

(8) MENU/ENTER Button
(9) Multi-Select Button
(10) Battery Cover




2-2 LED Indicators

This is what the LED indicators located on the top of LCD monitor mean:

Power Mode Flash Mode
(Green LED) (Red LED)

18:00—— )

2002/10/10— B

(1) White balance display

(2) Current working mode (Single, Self-timer photography, Multi Shot)
(3) Remaining battery power

(4) Flash status

(5) Macro, Portrait and Landscape mode
(6) Zoom lever

(7) Image resolution

(8) Possible number of shots

(9) Image quality

(10) Memory card loaded symbol

(11) Time display

(12) Date display
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2-4 Power Supply

@ Slide the lens cover toward the left gently, the camera will turn on after you hear

two beeps.

C oo |

@ Use the lens cover located on the front of the camera to turn on/off camera. After
you turn on the camera, the red LED will be blinking, and then the last image
recorded appears on the LCD monitor.

'S

NOTE

* If no operation is carried out for a fixed amount of time (default: about 3 minute), the
power is turned OFF to prevent battery wear. This is called "Auto Power OFF". You can
press the “Mode Display Button” to restart the camera.

* The following features will automatically save the configuration before you turn off the

camera unless you selected "Reset Default" to restore the camera to its factory
settings.
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2-5 Mode Dial

You can select the working mode by using this Mode Dial:

Mode Description
1. SET Setup mode Use this mode to adjust camera settings.
2. & Movie mode Use this mode to record video (movie) clips.
3. ] Playback mode  Use this mode to view images / video clips, delete

images / video clips, view a slide show, or view
thumbnail displays.

Choose this mode to use mass storage or PC

4. PC PC Mode Camera

5. a Record Mode Use this mode to capture still images.

2-6 Specifications

Lens: 8.46mm

Image Sensor: 1/2" CMOS with 3.1 mega pixels

Focus: F=2.8

Sensitivity: ISO 100

White Balance: Auto, Sunny, Cloud, Tungsten, and Fluorescent.

Shutter: Electrical

Shutter Speed: 1/15 sec. ~ 1/2000 sec.

Storage Media: 16MB Internal Flash Memory
SD Card (MMC compatible) Slot
(supports 4/8/16/32/64/128/256/512MB)

Image File Format: Still Image for JPEG

Movie: AVI

Image Resolution:
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H:2592x1944 (Firmware Interpolation Technology)
M:2048x1536
N:1600 x 1200
L:1024 x 768

Digital Zoom: 4X Digital Zoom

Focal Range Standard: 60cm ~ Infinity

Focal Range Macro: 15~18cm

Self-timer: 10 sec. delay

PC-CAM Mode: QVGA (320 x 240) 12~15 fps

Flash Mode: Auto, Red-eye reduction, Off

TV-OUT: NTSC / PAL system selectable

PC Connector: USB (Ver. 1.1)

Movie File: Recording 200 sec. continuous movie file with QVGA (320 x 240) format
(16MB internal memory)

The table below shows the approximate number of shots that you can take at each
setting based on 16MB internal memory.

Quality/Resolution | 1024 x 768 | 1600X1200 | 2048X1536 [2592x1944
% Super Fine 73 27 20 10
16MB
** Fine 147 54 41 20
% Normal 295 109 82 41

* The above data shows the standard testing results. The actual capacity
varies according to the shooting conditions and settings.

*  Power Supply: 2 x AA Alkaline batteries or supports CRV-3
* Dimensions: 95.8 x 56.6 x 37.9 mm (WxHxD) (without protruding parts)
*  Weight: About 112g (batteries excluded)

2-7 System Requirements

Please refer to the minimum system requirements for the digital camera. We recommend
that you use a computer system that exceeds the minimum requirements in order to
utilize the camera at its optimum efficiency. The minimum system requirement for the
digital camera is as follows:

System requirements (Windows)

CPU Pentium 166 MHz processor or higher
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0os Windows 98/98SE/Me/2000/XP
Memory 32MB RAM (64MB recommended)

Free Space on .
128MB hard disk space

Hard Disk
Required A CD-ROM drive,
Devices An available USB port
. Color monitor (800x600, 24-bit or higher
Color Monitor
recommended)

Chapter 3 Getting Started

3-1 Attaching the Strap

@ Insert the thin end of strap into the strap holder.
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@ Stretch the strap tightly.

3-2 Loading Batteries

@ Turn off the power of camera.
Insert 2 x AA alkaline batteries or a rechargeable battery. Please make sure the
batteries are full of power. If the batteries are low, please change new batteries as soon
as possible to keep the camera operating normally.

@ Close and lock the battery cover.

NOTE

Do not open the cover roughly to avoid damaging the battery compartment cover.
< If the battery power indicator shows only one black block that means that power is
available, and you can continue to use the flash.
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< When the battery indicator turns red, you cannot take still pictures or movies any more.

< Any pre-setting date/time value will be retained in the camera's memory for about 3
minutes when replacing the batteries. We still suggest you to double check the
date/time setting after changing new batteries.

3-3 Loading and Removing the Memory Card

1. Loading the memory card.

@ Make sure to turn off the camera.

@ Insert the memory card in the direction of the arrow.

2. Removing the memory card
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@ The memory card will bounce upward.

@ Pull the memory card out with your fingers in the correct direction.

NOTE

@ There is 16MB internal memory built-in to the camera to save your data:

If there is a memory card inserted, it will be the top priority for saving data.
If you want to store data in the internal memory, please remove the memory card first.
@ The specification of a memory card applicable to this camera is SD or MMC
(4/8/16/32/64/128/256/512MB).
@ If inserting the memory card in the wrong direction, it will not fit. Do not insert the card
roughly to avoid damage.
@ If the camera detects no memory card, please gently wipe the metal interface of the
card with a soft cloth and reload the card again.

3-4 Shutter Button

®=

Press the Shutter button down fully and the camera beeps; then releases the Shutter
button to take a picture.

3-5 Setting Up the OSD Language

Before using the camera, please turn the Mode Dial to Setup Mode and then select
"Language" to set the OSD language.
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3-6 Date/Time

Before using the camera, please turn the Mode Dial to Setup Mode and then select
"Date/Time" to set the date and time.

Chapter 4 Basic Operation

4-1 Recording a Still Image

To record a still image, perform the following:

1. Click the Power button to turn on the camera. M1n;:
2. Toggle the MODE button to select the ﬁ mode.
3. Look at the image on the image LCD display or

viewfinder to compose your shot.
4. Press the shutter button. ) 2002’13‘1’2
4-2 Recording a Video Clip
To record a video clip:
1. Click the Power button to turn on the camera. 5 e
2. Toggle the MODE button to select the ”ES mode. L]
3. Start recording a video clip by pressing the shutter

button. =

18:00

The elapsed time is displayed on the image LCD
2002/10/10

display.

To stop recording, press the shutter button.

4-3 Imaging Tips

For a successful image, please follow these suggestions.
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e Hold the camera level with both hands and brace your elbows lightly against your body.

e Take care to keep your fingers, hair and the camera strap away from the camera lens.

e Use the viewfinder or image LCD display to frame your shot.

e When using the viewfinder, brace the camera against your forehead to stabilize your
shot.

4-4 Viewing Still Image/Video Clip

In the =] mode, you can view still images/video clips stored in the camera’s internal or
card memory on the image LCD display. You can also connect the camera to a TV monitor in
this mode to playback the still images/video clips.

On the Image LCD Display @ 13

Still Image

To view a recorded still image, follow these steps:
1. Click on the Power button to turn on the camera

2. Toggle the MODE button to select the (3]

mode.
The latest captured image (or the starting scene if the latest captured video clip will be

displayed) on the image LCD display.
3. Select the image that you want to view by using

the 4 or } button. To view the previous 73
image, press the 4 button.
To view the next image, press the » button.

Video Clip

To view a recorded still image:
1. Click the Power button to turn on the camera.

2. Toggle the MODE button to select the ] mode.
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3. Select the video clip you wish to view by using the @ button.

<
4. To stop playback, press the button.

On a TV Monitor

Television monitors can be used to playback still images or video clips.

1. Set the appropriate video output mode (NTSC/PAL) corresponding to your TV standard.
® From the SETUP, select VIDEO MODE.

Connect one end of the video cable to the video output connector of your camera.
Connect the other end of the video cable to the video port of your television.

Turn on the camera and TV.

Toggle the MODE button to select the ] mode.

Playback the recorded images the same way as you would playback them on the image
LCD display.

NOTE

< The VIDEO OUT function is highly power consumptive. So the batteries may need to be
replaced sooner than normal.

4-5 Displaying Thumbnail Images
This function allows you to view nine thumbnail

images on the image LCD display simultaneously so
you may search for a particular image.

(BN

1. Click on the Power button to turn on the camera,
and toggle the MODE button to select the 3

mode.

2. Press the 5] button until thumbnail screen
appears on the display screen.
| Nine thumbnail images appear (assuming there are nine or more images in
memory).
B 1o view a full-size image, selecting it by using the A , ¥ < or >
button, and then press the t3 button.
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4-6 MENU/ENTER Button

A

You can perform different operations in the different mode by using the MENU/ENTER
button, e.g. select, confirm, go forward and backward.

4-7 Deleting Still Image /Video Clip

There are two ways to erase images:

Delete One and Delete All

1. Recorded images in the memory card cannot be deleted when it is write-protected.

2. To delete the pictures recorded in the memory card, make sure to insert the card before
deletion.

3. To delete the pictures recorded in the camera (internal memory), do not insert any
memory card or the camera will not be able to read the internal data with an external
memory card attached.

4. External memory (memory card) always has priority over internal memory — whenever a
memory card is inserted into the camera, the camera will use the memory card for both
capture and playback.

4-8 Flash Button
The flash is designed to function automatically when lighting conditions warrant the use of
flash. You can take an image using a flash mode suitable to
your circumstances. If you change the flash mode, the camera
will retain that setting even if the camera is turned off.

1. Open the lens cover; turn the mode dial to 0 mode, and

power on the camera.

2. Press the i button located on the rear side of the camera

repeatedly until your desired flash mode appears on the LCD

-17-



monitor.

3. Compose the picture and press the shutter button.

This button is only working in the Record Mode. The camera has four flash modes:

Automatic Flash, Red-Eye Reduction, Fill Flash (on), and Flash Off (default). The modes

appear cyclically when you press the i button on the rear side of the camera. The table

below will help choose the appropriate flash mode:

Flash Mode

Description

( iA ) Auto Flash

The flash fires automatically according to the ambient
conditions. Select this mode for general photography.

C 5 &, Red-eye Reduction

The flash emits a precursor-flash before the main flash
fires. This causes the pupil in the human eye to constrict,
reducing the red-eye. Select this mode when taking
pictures of people and animals in low-light conditions.

(il Fill Flash on

The flash will always fire regardless of the surrounding
brightness. Select this mode for recording images with high
contrast (backlighting) and deep shadows. Also known as
forced flash.

[@] Flash off

The flash will not fire. Select this mode when taking images
in a place where flash photography is prohibited, or when
the distance to the subject is beyond the effective range of
the flash.

4-9 Digital Zoom

Using digital zoom, images appear closer. Whereas
digital zoom is a compelling feature, the more an image
is enlarged (zoomed), the more pixilated (grainier) the

image will appear.

1. Click the Power button to turn on the camera.

g_\
=8

18:00
2002/10/10
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2. Toggle the MODE button to select the ﬁ mode.
3. Press the M\ or v button to activate 4X digital zoom function.

4. Press the shutter button to capture a “zoomed” image.

4-10 Mode Display Button

=

1.This button is only working in the Record Mode. Press this button and you can change the
LCD monitor to several displays.
Full Display - Standard > LCD Monitor Off - Full Display

2.Press the "Mode Display Button" to enter the "Play Mode" to view the images when the
camera is powered off.

3.In the Record Mode, the camera will be auto power off because of the power saving
function. You can press the "Mode Display Button" to turn on the camera again.

4-11 Macro Button

Use the macro mode to shoot a close-up of the subject,

such as flowers or insects. The effective range is between
15cm and 18cm.
1. Open the lens cover, turn the mode dial to 0 mode,

and power on the camera.

2. Move the focus switch located on the front side of the
camera to the $ position.
| The \” icon appears on the LCD monitor.
3. Compose the picture.
4. Press the shutter button.
| To disable macro photography, slide the focus switch back to portrait mode or
landscape mode.
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4-12 Portrait and Landscape Button

1. Open the lens cover, then the mode dial to O mode,

and power on the camera.

2. Move the focus switch located on the front side of the

{3
camera to the - position.

3. Compose the picture. '%’é

4. Press the shutter button.

L

Chapter 5 Camera Menus

5-1 Record Mode ©3 Capture »

. » Single
Smgle Self timer
To record a still image, please refer to section 4-1. Multi Shot
Self-Timer 100

M &

This feature allows you to get into the scene when -
taking group images.
1. Secure the camera to a tripod or place it on a

stable surface. eI

2. Click the Power button on the camera, and toggle -
the MODE dial to select the ﬁ mode.

3. Press the MENU/ENTER button into Capture menu, and select self-timer by using

the A or ¥ button.

2002/10/10
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. The Q) icon appears on the image LCD  display.

5. Compose the scene.

6. Press the shutter button. The self-timer function is activated.

7. After ten seconds, the camera takes an image. In the first 7 seconds, the self-timer

indicator blinks at a relatively slow rate and then blinks rapidly for the last 3 seconds.

Multi-Shot

This function allows you to capture the continuous moving images. After photography is

finished, check the images and select the most satisfied image from your computer.

The approximate number of burst photography varies according to the quality conditions

and settings.

H: 2592x1944 approx. 1
M: 2048x1536 approx. 2
N: 1600x1200 approx. 2
L: 1024x768 approx. 2

The remaining capacity of internal memory also affects photography in this mode.

The image resolution (size) determines the size of your image
and how many images can be stored in the internal memory

Internet.

Image Resolution

4 Resolution »

or on the memory card. The higher resolution (larger size) P H:2502x1044
produces a large size image but takes up more space in M:2048x1536
memory. Lower resolution (smaller size) takes up less N:1600=1200
memory space, suitable for sharing images via email or the L:1024x768

1. Click the Power button on the camera, and toggle the

MODE dial to select the O mode.
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2. Press the MENU/ENTER button, then select image resolution by using the 4 or
> button.
3. Usethe A or ¥ buttons to select the setting that you desire, and press the

MENU/ENTER button to confirm the selection.

Image Quality

The image quality determines the compression ratio of your image and how many images
can be stored in the internal memory or on the memory

card.

The higher quality produces a less compressed image but < 9ualltyl >
takes up more memory space. Lower quality takes up less > *** Super Fine
memory space, suitable for sharing images via email or the * Fine
Internet. * Normal

1. Click the Power button on the camera, and toggle the
MODE dial to select the 0 mode.

2. Press the MENU/ENTER button, then select image quality by using the 4 or ’
button.

3. Usethe A or ¥ buttons to select the setting that you desire, and press the

MENU/ENTER button to confirm the selection.
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WHITE BALANCE

Automatic white balance is recommended for most cases. For particular circumstances, you
may manually select another white balance preset

according to the ambient lighting conditions.
1.

. Press the MENU/ENTER button, then select white # Fluorescent

Click the Power button on the camera, and toggle the 4 White Balance p

MODE dial to select the 0 mode.

balance by using the < or > button.

. Usethe A or ¥ button again to select the desired white balance.

. Press the MENU/ENTER button to confirm the selection.

Exposure Value

The camera will automatically adjust the camera shutter
speed for the proper exposure of each scene. Occasionally,
it is desirable to manually override the automatic exposure
value (EV) to accommodate special scene circumstances. ooooomooooo
. 0 +

1.

4 Exposure Value

Click the Power button on the camera, and toggle the (m):Set [y )+

MODE dial to select the 0 mode.

. Press the MENU/ENTER button, then select exposure value by using the 4 or

} button.

. Usethe A or ¥ button again to specify the desired EV.

| The EV range is from -1.5 to +1.5 in steps of 0.3 EV.

. Press the MENU/ENTER button to confirm the selection.
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5-2 Play Mode =)

In Play Mode, users can review the recorded still and movie pictures. To review the pictures,
perform the following:

=

1. Turn the Mode Dial to Play Mode 3}

2. Use the lens cover located on the front of the camera to turn on the camera. After you
turn on the camera, the last image recorded appears on the LCD monitor.

Auto Play
The auto play function enables you to playback your images back automatically in
sequential order as a slide show. This is a very useful and entertaining feature for reviewing

recorded images and for presentations.

1. Click the Power button to turn on the camera, and
» Auto Play
toggle the MODE dial to select the ] mode. Delete One
Delete All
2. Press the [Z) button until thumbnail screen appears Format
DPOF
on the display screen.
»1:00
3. Press the MENU/ENTER button into auto play 2:00
3:00
option. 45188

4. Set the playback interval by using the 4\ or ¥

button again, and then press the MENU/ENTER button to confirm the selection.

The slideshow starts, displaying your images on the image LCD display, one by one, at

the set interval.

To stop the slideshow display, press the MENU/ENTER button.
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Delete One
1. Click on the Power button to turn on the camera, and toggle the MODE button to select
the (=] mode.

2. Press the 3 button until thumbnail screen appears on

. Auto Play
the display screen. » Delete One
Delete All
Format
3. Press the MENU/ENTER button, then select
DPOF
Delete One by using the 4\ or ¥ button.
Delete One
4. Press the MENU/ENTER button, then the Delete Yes No
One menu appears.
5. Use the 4 or >button to select Yes or No.
6. Press the MENU/ENTER button to confirm the selection.
Delete All
1. Click on the Power button to turn on the camera, and
Auto Play
toggle the MODE button to select the ] mode. Delete One
2. Press the =2 button until thumbnail screen appears on > Delete Al
Format
the display screen. DPOF

3. Press the MENU/ENTER button, then select Delete All

Delete One by using the 4 or ¥ button. Yes No

4. Press the MENU/ENTER button, then the Delete
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All menu appears.
5. Use the 4 or >button to select Yes or No.
6. Press the MENU/ENTER button to confirm the selection.

FORMAT

Formats the memory card and erases all data from the card.

. Auto Play
1. Click on the Power button to turn on the camera, and Delete One
Delete All
toggle the MODE button to select the ) mode. » Format
DPOF
2. Press the E' button until thumbnail screen appears on
the display screen.
pay _ Format
“@ »
3. Press the MENU/ENTER button, then select Yes No

Format by using the 4 or W button.
4. Press the MENU/ENTER “-/ button, then the Format menu appears.
5. Use the 4 or >button to select Yes or No.

AR
6. Press the MENU/ENTER button to confirm the selection.

NOTE

< A memory card cannot be formatted if it is write-protected.

DPOF (Digital Print Order Format)

DPOF allows you to embed printing information on your memory card.

Using DPOF you can select an image to be printed and then specify how many prints you
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would like. You connect your memory card to a DPOF enabled printer that accepts SD
memory cards. The DPOF/card-compatible printer will read the embedded information on
the memory card and print your images as specified.

1. Click on the Power button to turn on the camera, and toggle the MODE button to select

the (=] mode.
2. Press the 3 button until thumbnail screen appears on the
Auto Play
Delete One
display screen. Delete All
= Format
» DPOF
3. Press the MENU/ENTER “=“ button, then select DPOF by
using the A or ¥ button. DPOF
4. Press the MENU/ENTER button, then the DPOF et Genes|

menu appears.
5. Use the < or >button to select Set or Cancel.

6. Press the MENU/ENTER button to confirm the selection.
S
NOTE

< The DPOF function can only be operated with the memory card inserted.

5-3 Setup Mode

By using the Setup Mode, you can adjust the basic camera functions, including: OSD
Language, Date/Time, Auto Power off, TV-Out, Frequency and Default Setting items. To
setup these items, perform the following:

1. Turn the Mode Dial to Setup Mode E=d.
2. Use the lens cover located on the front of the camera to turn on/off camera. After you
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turn on the camera, the green LED will be bright, and the Setup screen will be shown on

the LCD monitor.

LANGUAGE

Sets the OSD menu language.

1. Usethe M or ¥ button to highlight LANGUAGE

2. Press the MENU/ENTER button to confirm the selection.

DATE/TIME

Sets the date and time.

1. Use the 4 or } button to highlight DATE/TIME.

2. Press the MENU/ENTER button to set DATE/TIME.

3. Usethe A or ¥ button to adjust DATE/TIME.
4. Press the MENU/ENTER button to confirm the selection.

AUTO POWER OFF

You may specify a power-off time.

1. Use the 4 or } button to highlight AUTO POWER OFF.

2. Usethe A or ¥ button to select the desired setting.

3. Press the MENU/ENTER button to confirm the selection.
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TV-Out Operation

Using the TV-Out function offered by the camera, you can transfer images to other display
devices, e.g. a TV or computer. To transfer the images, follow this method:

Please select the correct video type for the connected device before transferring images.
77

Turn the Mode Dial to Setup Mode and select the correct video output
type for your selection: NTSC or PAL.

2. When you use this function; please use the video cable provided with the camera to
connect the camera and output device.
3. You can turn on the camera. There will no images shown on the LCD Monitor. All the

images and information will be shown on the output device's display via the video output
cable.

NOTE

< The camera will perform normally when you enable the TV-Out function. The only
difference is the location to show the images, and the image information will be from the
LCD Monitor to the video output device's display.

< While using the camera, after you connect the video cable to the camera, the images will
be no longer shown on the LCD Monitor. If you want to restore the display status on the
LCD Monitor, please disconnect the video cable from the camera.

Frequency

The camera supports different lighting frequencies: 50Hz and 60Hz. When photography
under fluorescent lighting, select the correct frequency setting depending on your local
area's voltage. However, under other lighting situation, select "disable" for this setting.
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1. Use the 4 or } button to highlight Frequency.
2. Usethe M or ¥ button to select the desired setting.

3. Press the MENU/ENTER button to confirm the selection.

Default Setting

1. Use the < or > button to highlight Default Setting.
2. Usethe A or ¥ button to select the desired setting.

3. Press the MENU/ENTER button to confirm the selection.

5-4 Movie Mode *3

You can use Movie Mode to record movie pictures (not including audio). To record movie
pictures, just do this:

4. Turn the Mode Dial to Movie Mode ﬁ

5. Use the lens cover located on the front of the camera to turn on the camera. After you
turn on the camera, the last image recorded appears on the LCD monitor.

7. Press the Shutter button to start recording. Press the Shutter button again to stop
recording.

8. The LCD Monitor will show the recorded time (seconds) while you are recording your
movie pictures.

&) NOTE

< To record the movie pictures, the maximum recording time depends on the free space of
the memory card.

5-5 PC Mode
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o To select the PC Camera or Mass Storage items in the PC Connection menu, perform
the following:

Using This Camera as a PC Camera

This camera can act as a PC camera, allowing you to hold a videoconference and talk to
business associates over the Internet or corporate Intranet, or conduct real-time
conversation with friends or family.

To use this camera as a PC camera, follow the steps below:

Step 1: Installing the PC camera driver

Step 2: Connecting the camera to your computer

Step 3: Running software application (for example: ArcSoft Videolmpression)

System Requirements for Videoconferencing
To use this camera for videoconferencing, your computer must contain the following
components:

B Microphone

® Sound card

B Speakers or headphones
B Network connection

Step 1: Installing the PC Camera Driver
The PC camera driver on the supplied CD-ROM is exclusively for Windows. The PC
camera function provided on this camera is not supported by the Macintosh platform.

Step 2: Connecting the Camera to Your
Computer

1. Click the Power button to turn on the camera.
2. Using the mode dial select the PC mode, then select “PC

Camera” by using the 4 or ¥ button.

3. Connect one end of the USB cable to an available USB
port on your computer.
4. Connect the other end of the USB cable to the USB connector on the camera.

5. Position the camera steadily on top of your computer monitor.
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Step 3:Running software application (for example: ArcSoft

Videolmpression)

Turn your PC on if it isn’t already on. Click the Start button in the Windows Taskbar, and
select Programs > ArcSoft Videolmpression > Videolmpression. The following
Videolmpression main screen will appear.

(Aot

aesort yicl@o 4 :
Impression

Video creation and presentation made easy

Click the New button and the following Album screen will appear.

Pyo—

A B
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Click on Capture _ and the Capture screen will appear.

Then click on Record = and you can capture the video.
If you want to stop capturing, press ESC or click on Pause -

Function description for the major icon (Genius TWAIN UI)

JE\JJJE B

G-Shot G511

i@

AV L
N -
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H.

NOTE

Play the .avi file.

Preview the video image.

Take a picture.

Capture image with full motion video.

Send photo through e-mail.

Use PC camera as a security monitoring system.

Exit the Genius VideoCAM Series Ul.

Convert AVI files into MPEG-1 format

B Make sure to install the USB driver before connecting the device otherwise unable to
install properly. If you encounter problems, uninstall the driver and software then follow
the proper installation.

B Should you need the device under high luminance environment, please follow the steps

as below:

&

Camera Control - Control > Exposure
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Function description for the security monitoring system
icon. (Genius TWAIN UI)

Gonius VideoGAM Sor

el

G-Shot G511 |

AVl | 7
vieocal 2% merm = Geniss ¥

Senstiity

® ® =

You can record any movements that appear in front of your monitor automatically. It can also
record anytime until the HD is full. If there’s no movement, it will shut down automatically
after four seconds or until there is new movement. It's a great security monitoring system

and you can set the software so it works at times when you’re not around.
A. % Setup time of the security monitoring system.

i\
When you start to record video, please press the play - button.

Sensitivity

») ,!) Rkt =
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NOTE

W The recording file will be retained in C:\WINDOWS\Album.

Chapter 6 Driver Installation

6-1 Installing the Camera Driver to the PC

You can use the PC Camera and Mass Storage functions of the camera via PC. To install

the proper camera driver, just follow this:

1. Insert the software CD-ROM supplied with the package into the CD-ROM drive.

2. The Auto-run program will be executed and the welcome screen appears:
(If your CD-ROM drive doesn't support the auto-run function, then double click on the
"My Computer" icon on the pc. Double click on the CD-ROM drive icon and click the
Setup.exe file in the root directory.

3. Click the Install driver to install the driver, and this screen will appear:

x|

=T e T

4. Click on Next to continue the setup program. After you installed the camera driver
successfully, this message appears on the screen:

5. Click Finish to restart the computer and finish the camera driver installation.
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6-2 Installing the Software Applications to the PC

Install Arcsoft Software (take Photolmpression Installation for example)

1. Insert the software CD-ROM supplied with the package into the CD-ROM drive.

2. The Auto-run program will be executed and the welcome screen appears. If your
CD-ROM drive doesn't support the auto-run function, double click on the "My
Computer" icon on the pc. Then double click on the CD-ROM drive icon and click the
Setup.exe file in the root directory.

3. Click on Arcsoft Photolmpression to install, and this screen will appear:

Choose Setup Language x|

Select the language for this installation fram
i the choices below

z
Cancel

4. Select the language for installation. Click OK to confirm your selection.
5. You will see the Welcome screen. Click Next to continue.
x|

6. Enter Software License Agreement window.
Please click Yes to continue the installation.
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[rcSot Photolmpression Sotup |
License Agtcement

Fiess the PAGE DOWN key o see the rest o the agieement.

[End User License Agieement

.................. E]

e ArcSotInc. Catelly s s icen sgteetient befre using the product. Using.

n
e cn only one computer a aygive tme, The sotwate s i use” when i ether

, the.
selup will close. To nstall Photlmpression you st accept i agreemer.

staighield

7. Please follow the instructions of the instal
folder and the components you need.

[cSoft Photalmpression Setup |
Choose Destination Location

ot oer e St fArg oft

Setup villnstal Photolmpresion it folowing folde.

lation Wizard to select a destination

. cick Nex. ik B o
ancthe foder.
Destistion Folder
C\Pragiam Fles\ArcSt\Photnpression 3 Buowse.
InsteiShield

[cSoft Photalmpression Setup |
Select Components

Descipton
Instal Photolmpession
o
Space Reqied on C: 256824 K
Space Avaiatle on C. 214456K.
InsteiShield
<Back | New> Concel

8. Please select the program folder you want to install
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9. When the installation is completed, the window below will appear. Click Finish to end
the installation.

InstallShield Wizard Complete

Cick Fiish to complee Setup.

B

6-3 Transferring Recorded Images to Your Computer

You can share recorded images/video clips with your family or friends via e-mail or post
them on the Web. Before doing those things, you need to connect the camera to your
computer by using the USB cable and then transfer the images/video clips. To transfer
images/video clips from the camera to your computer, follow these steps:

Step 1: Installing the USB driver

Step 2: Connecting the camera to your computer

Step 3: Downloading images/video clips

Step 1: Installing the USB Driver

The USB driver on the supplied CD-ROM is for Windows XP/Me/2000/98SE/98.
1. Insert the CD-ROM packaged with the camera into the CD-ROM drive.

2. Follow the on-screen instructions to complete the installation.

3. Restart your computer.
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Step 2: Connecting the Camera to Your Computer

1.
2.

6.

Click the Power button to turn on the camera.

Using the mode dial select the PC mode, then select mass storage by using the 4\ or

W button.

Connect one end of the USB cable to an available USB
port on your computer.

Connect the other end of the USB cable to the USB
connector on the camera.

Look for a new “removable disk” appearing in the “My
Computer” Window.
Your recorded images/video clips will be in a folder on this “removable disk”.

Step 3: Downloading Images/Video Clips

When the camera is turned on and connected to your computer, it is considered to be one
disk drive. You can download images/video clips by copying them from the “removable disk”
to your hard drive or other storage disk.

For computers running Windows

Open the “removable disk” by double clicking on it. Double click on the folder. Your images
are inside the folder(s). Select the images that you want, and then choose Copy from the
Edit menu. Open the destination location and choose Paste from the Edit menu. You may
also drag and drop image files from the camera to a desired location.
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